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Version history

Version Date Description
1.0 04/2020 Initial release of this Getting Started Guide document.
1.1 10/2021 Addition of vector tiles and GeoPackage formats to the product.

Purpose of this document

This document provides information about and insight into the OS Detailed Path Network product and its
potential applications. For information on the contents and structure of OS Detailed Path Network, please
refer to the Overview and Technical Specification.

The terms and conditions on which OS Detailed Path Network is made available to you and your
organisation are contained in that Ordnance Survey customer contract. Please ensure your organisation has
signed a valid current customer contract to be able to use OS Detailed Path Network.

We may change the information in this document at any time, giving you the notice period set out in your
contract. We do not accept responsibility for the content of any third-party websites referenced or
accessed in or through this document.

This document has been screened according to Ordnance Survey's Equality Scheme. If you have difficulty
reading this information in its current format and would like to find out how to access it in a different
format (braille, large print, computer disk or in another language), please contact us on:

+44 (0)3456 05 05 05.

Copyright in this document

© Ordnance Survey Limited 2021. This document (including for the avoidance of doubt, any mapping
images reproduced within it) is protected by copyright and apart from the rights expressly granted within
this document to use the content, all rights are reserved. Any part of this document may be copied for use
internally in your organisation or business so that you can use OS Detailed Path Network under the terms
of your licence (but not otherwise).

No part of this document may be reproduced or transmitted in any form or by any means (including
electronically) for commercial exploitation, onward sale or as free promotional material without getting the
written consent of Ordnance Survey beforehand.

Trademarks

Ordnance Survey, OS, the OS Logos, OS MasterMap, OS Terrain, AddressBase, GeoPlace, TOID and
OSGB36 are registered trademarks, and OS MasterMap Highways Network and OS Detailed Path
Network are trademarks of Ordnance Survey, Britain’s mapping agency.

[:25 000 Scale Colour Raster
Explorer

OS MasterMap Topography Layer
OS MasterMap Highways Network
OS Terrain 5

OS Terrain 50

Contact details

OS website ‘Contact us’ page (https://www.ordnancesurvey.co.uk/contact-us).
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| Introduction

The OS Detailed Path Network product is a topologically connected link and node network for roads,
tracks, paths and rights of way within the National Parks of Great Britain. The product has been created
from a number of existing Ordnance Survey data sources, including OS MasterMap Topography Layer,
OS MasterMap Highways Network, 1:25 000 Scale Colour Raster, OS Terrain 5 and OS Terrain 50. The
data is intended to provide sufficient detail for routing pedestrians, cyclists and horse riders when using
mobile devices, with a typical positional accuracy of 10m.

The OS Detailed Path Network dataset was originally released in 2015. It is currently updated on an annual
basis and coverage is restricted to the National Park areas of Great Britain. More information about the
product, along with links to support documents, can be found on the OS Detailed Path Network Product
Support page on the OS website (https://www.ordnancesurvey.co.uk/business-government/tools-
support/path-network-support).

.1 Adherence to standards

OS Detailed Path Network is a derived product that has been designed with consideration of the INSPIRE
(https://inspire.ec.europa.eu/) Transport Networks Data Specification, although INSPIRE does not apply to
off road transport. Due to the process of deriving OS Detailed Path Network, feature instances and their
identifiers will be regenerated at each data refresh.

.2 Support links

Throughout this document, we reference files or documents as part of your 'Getting Started' instructions.
For ease of reference, we've compiled a list of these in Annex A: Product support links.
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2. Downloading the data

The OS Detailed Path Network product is available for the |5 National Park areas within Great Britain.
The dataset is released in three formats: Geography Markup Language (GML), GeoPackage and vector tiles.
All formats are compressed into a regular zip file (.ZIP).

Before loading the data, you will need to unzip it by using any of the regular zip programs available or via
the facility within the Windows |0 operating system.

As the areas covered by the National Parks differ in size, the downloads in turn vary in size, from | IMB for
the Lake District National Park to around 2MB for the Northumberland National Park.

The data is available as download only, and there are no plans for the data to be made available on hard
media.

This getting started guide focuses solely on using the product in GML format. For guidance on using the
product in GeoPackage or vector tiles formats, please see the following two getting started guides, which
are available on the OS website:

» Getting Started with GeoPackage guide (https://www.ordnancesurvey.co.uk/documents/setting-started-
with-geopackage.pdf)

e Getting Started with Vector Tiles guide (https://www.ordnancesurvey.co.uk/documents/user-
suides/getting-started-with-vector-tiles-v|.0.pdf)
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2.1 Downloading the schema (GML format only)

To use the GML data format, some Geographic Information Systems (GIS) may need third-party data
translation software to make the data usable within their Gl application. To help with this, we provide a
downloadable XSD schema

(https://www.ordnancesurvey.co.uk/xml/schema/detailedPathNetwork/v | /detailedPathNetwork.xsd) on the
OS Detailed Path Network Product Support page on our website.

I. Go to the OS Detailed Path Network Product Support page on the OS website
(https://www.ordnancesurvey.co.uk/business-government/tools-support/path-network-support).

2. Find the Product schema (XML) link on the page (it is under the Getting started section which is
located at the top of the page):

Getting started

The Detailed Path Network (DPN) is a digital representation of the roads, tracks
and paths in the National Parks of Great Britain that the public may use to travel

on and enjoy the great outdoors.

i

\

i ; - el \ [\

Al 5 /
Product guide (PDF) Product schema (XML)

The product is designed to facilitate applications and services to provide routes for The product schema for 05 Detailed Path Networks.

pedestrians, cyclists and horses being ridden, primarily for leisure purposes.

3. You can either:

a. Right-click on the link and Save link as to a location of your choice
or
b. Click the link to open the schema online, then copy and save the content into a text editor
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3.  Loading the data (GML format)

This section provides basic steps on loading the OS Detailed Path Network data into some common Gl

applications.

General information about using GIS with OS data is available on the Using GIS software page on the
OS website (https://www.ordnancesurvey.co.uk/business-government/tools-support/gis/using-gis).

3.1 QGIS

These instructions are based on QGIS 3.4 — a Long Term Release.

I. Launch QGIS and click Settings > Options.

2. Select CRS from the left-hand menu, then check that the coordinate reference system is set to British
National Grid in the Default CRS for new projects section and in the CRS for new layers section.

>, General

‘)& System

/

§

-
./, Options | CRS

B

B Data Sources
Rendering

E Canvas & Legend

W Default CRS for new projects
Don't enable 'on the fly' reprojection
® Automatically enable ‘on the fly’ reprojection if layers have different CRS
Enable 'on the fly’ reprojection by default
Always start new projects with this CRS
JePsG:27700 - 05GB 1936 / British National Grid |

W CRS for new layers
When a new layer is created, or when a layer is loaded that has no CRS
Prompt for CRS
Use project CRS
® Use default CRS displayed below

N epsc:27700 - 0SG8 1936 / British National Grid |

w Default datum transformations
Ask for datum transformation when no default is defined

| Source RS | Destination CRS | Source datum trans | Destination datum transform

Selact...

If British National Grid is not already set as the default CRS in these sections, click the Select...button
at the end of each field and type 27700 into the filter box to find and select British National Grid.
Alternatively, if you intend to use Latitude and Longitude columns, select ETRS89 [EPSG: 4258].

3. Click OK.
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4. Back in the main window, open the Data Source Manager.

(2 Untitled Project - QGIS

NEERRY O
) AL W

Brows P®
Open Data Source

f“i

L “|Manager (Ctrl+L)
5.7 Favorites

» 0] Home

Project Edit View Layer Settings Plug

5. Select Add Vector Layer from the left-hand toolbar, and under Source, click the [...] button to browse to

your Vector Dataset(s).

(2 Data Source Manager | Browser | Vector

| . Browser Source Type
Vector : £

| ®) File Directory Database Protocol: HTTP(S), cloud, ete.
- Encoding System
: Source

Vector Dataset(s)

# 4 Spatialite
o PostgresaL
« MsSQL
¢ Oracle

082, DB2

m Virtual Layer

@‘ WMS/WMTS

£ wes

WEFS

5?;: ArcGIS Map Server

@)lp ATCGIS Feature Server

GeoNode

L

Add Help
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6. Set the file type to show only Geography Markup Language (.gml) files, then browse to the folder where
the OS Detailed Path Network data is located.

(&) Open OGR Supported Vector Dataset(s)
™ 2

Organise New folder

# Quick access
= This PC

¥ Network

I
All files
GDAL/OGR VSIFileHandler (*.zip *.gz *.1ar *1ar.gz *.19z *ZIP
Arc/Info ASCII Coverage (*.e00 *.E0Q)
Arc/Info Generate (*.gen *.GEN)
Atlas BNA (*bna *BNA)
AutoCAD DXF (*.dxf *.DXF)
AutoCAD Driver (“.dwg *DWG)
Comma Separated Value (*.csv *.CSV)
Czech Cadastral Exchange Data Format (*.vfk *.VFK)
EDIGEO (*.thf *THF)
EPlinfo .REC (*.rec *REC)
ESRI Personal GeoDatabase (*mdb *MDB)
ESRI Shapefiles (*shp *SHP)
ESRI Shapefiles (*shp *.SHP)
GMT ASCIl Vectors (.gmt) (*.gmt *.GMT)
GPS eXchange Format IGPX] (*.gpx *GPX)
GPSTrackMaker (*.gtm *.gtz *.GTM *.GTZ)
GeoJSON (*.geojson *GEQJSON)
GeoJSON Newline Delimited JSON (*.geojsonl *.geojsons *.n
GeoPackage (*.gpkg *GPKG)

Hydrographic Transfer Format (*htf *HTF)

INTERLIS 1 (*.itf *mil =ili “ITF *XML *.ILI)

INTERLIS 2 (*.xtf *xml %.ili *XTF XML =ILI)

Idrisi Vector (.vet) (*vet 2VCT)

Keyhole Markup Language [KML] (*.kml *kmz *KML *KMZ)

File name:

~| (A fites ~

7. Select the file(s) to be loaded and click Open.

() Open OGR Supported Vector Dataset(s)
&« v 4 | M« Data > Original Data

Organise » New folder

B This PC
) 3D Objects
I Desktop
5| Documents
& Downloads
b Music
= Pictures
B Videos
‘ia 0SDisk (C:)

X
v O Search Original Data 2

B~ 1 @

FRBRECON BEACONS NATIONAL PARK.gml
B NEW FOREST NATIONAL PARK.gml

File name:

vl Geography Markup Language [

Cancel
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8. Click Add.

9. Next, select the Vector Layers you wish to load. There are three layers available for the OS Detailed
Path Network product:

a. Route — A lookup table that records collections of links representing a named entity which forms a
recognised and signed route that the public can use.

b. RouteLink — Line geometry representing the general alignment of roads, tracks, paths and rights of
way.

c. RouteNode — Point geometry at the start or end of a RouteLink feature which is used to record
the connectivity between links.

() Select Vector Layers to Add... X
Layer ID Layer name “ Number of features Geometry type
2 Route 5 None
0 RouteLink 17968 LineString25D
1 RouteNode 14194 Point25D
OK Select All V' Add layers to a group Cancel

For further details on the product structure and attribution of these features, please refer to the

OS Detailed Path Network Technical Specification document, which is available on the OS Detailed
Path Network Product Support page of the OS website (https://www.ordnancesurvey.co.uk/business-
government/tools-support/path-network-support).
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10. Select the RouteLink and RouteNode layers, then click OK to load the geometry into the QGIS map
window.

g "o Ao ™
Layers 2@
o &Y -HAO
= [¥) (¥ NEW FOREST NATIONAL PARK
¥ ¢ NEW FOREST NATIONAL PARK Bo...
t NEW FOREST NATIONAL PARK Ro...

I'l. The data can now be styled using the tools available within QGIS enhance visualisation of the data.
Additionally, it can be overlaid on other datasets to provide a backdrop mapping context.

Note: GML data cannot be spatially indexed, which means rendering can be slow. To improve performance, we

recommend that you save the data to another regular Gl format, such as an ESRI shapefile.

[ayers EC]
¢ §® T &~B AL

~ v (8] NEW FOREST NATIONAL PARK

NEW FOREST NATIONAL PARK Ro...

| — NEW FOREST NATIONAL PARK Ro...
r W VMLSU

The preceding screenshot shows what the OS Detailed Path Network data can look like when it has
been styled and superimposed upon other datasets, such as the OS VectorMap Local product.
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3.2 ArcGiIS Pro

The following instructions are based on ArcGIS Pro version 2.3 and assume that users have knowledge of
the Data Interoperability Extension to convert the supplied GML into a suitable ArcGIS Pro format.

I. Open ArcGIS Pro and create a new project. You may wish to select a basemap for backdrop context.

Southampton

Winchester

2. Click on the Analysis tab along the top menu.

[i:]

rt Analysis

5¢

Environments Tools

3. Select the Workbench option from the ribbon menu.

Workbench

Data Interoperability
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4. A new window will open, which provides access to the full interface of the Data Interoperability
Extension. The next steps assume basic understanding of using this main interface of FME, which is an
application provided by Safe Software that is embedded into ArcGIS Pro.

File Edit View Readers Transformers

Navigator
| E Transformers
E Bookmarks
v {8 User Parameters
& Published Parameters
& Private Parameters
fa Teol Resources
~ [@ Tool Parameters
ﬁ Mame: <not set>

-1

» B ANGT)

» B¢ Categorized
Y Embedded Transformers
¥ FME Hub

» B¢ Recent (6)
Q, Search Results

Parameter Editor  Transformer Gallery

Transformer Gallery & x

Q ol

% NOME — NONE (Untitied) - Workbench 2013.1

Writers Run  Tools Help

Main

[m]

DB Pe R X000 ROAS o’ o4 «+FODGCTED S B2

®

FME(R) 2018.1.1.0 - 20181107 - Buid 18567 - WINES - C:'\Program Files\ArcGIS\Data Interoperabiity for AreGIS Pro\

5. In this example, we will perform a simple conversion from GML to an ESRI file geodatabase using our
OS Detailed Path Network’s New Forest National Park dataset. Enter your parameters as shown in the

following screenshot:

# Generate Workspace *

Reader

Format: lGML (Geography Markup Language) VJ

Dataset: [ta\Original Data\NEW FOREST NATIONAL PARK.gml" | |...| [+

Parameters... Coord. System:

Writer

Format: ‘ Esri Geodatabase (File Geodb) v i

El 5D ([~

Dataset: | Path Network\Data\MyProject\MyProject.gdb™

Parameters... Coord. System:
(] import feature type definitions
Workflow Options

H-+E
(@ staticSchema E-+8E () DynamicSchema H-+H
B+8

- e
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Reader (Input)

Format: GML (Geography Markup Language).

Dataset: Location of your downloaded OS Detailed Path Network dataset.

Writer (Output)

Format: Esri Geodatabase (File Geodb).

Dataset: Location of the file geodatabase generated upon creating the ArcGIS Pro project.

6. Click OK.

7. You will see three Feature Types listed in the Select Feature Types dialog box:

a. Route — A lookup table that records collections of links representing a named entity which forms a
recognised and signed route that the public can use.
b. RouteLink — Line geometry representing the general alignment of roads, tracks, paths and rights of

way.

c. RouteNode — Point geometry at the start or end of a RouteLink feature which is used to record

the connectivity between links.

For further details on the product structure and attribution of each of the feature types, please refer to
the OS Detailed Path Network Technical Specification document, which is available on the OS Detailed
Path Network Product Support page of the OS website (https://www.ordnancesurvey.co.uk/business-

government/tools-support/path-network-support).

# Select Feature Types

Feature Type List

Ej’ Route
E}' Routelink
E RouteMNode

[ Q Filter

| [ selectal [ sorted

]

8. Tick the Feature Types you wish to translate, then click OK.

9. To start the workbench, click the green Run arrow at the top of the window.

ew Readers

2| >
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10. The translation will run. Wait until you see the final log message Translation was successful.

Mai
v Reader Feature Types ) ¥ Writer Feature Types
.|>Rnu1e o | 5 # b Route m
5 DRnuteLink ) e W Ty
| bRnutdlode 14,104 ~ b RouteNode E@]

e— A — )

v
< >
Translation Log & x
~ QoEres = = 4 12Wamings = @mformaten W =1 1B
211 ~
212 Route 5
213 Routelink 17568
214 RouteNode 14154
215
21€ Total Features Written 32167
217
DLE om0 P P A P P
219 e
220 =~ Feature caches have been recorded at every stage of the translation. .-

221 -~ Te inspect the reccxzded features, .
22z - click the feature cache icons next to the ports =
223 ==~ -—

DD e e st o 4 Bt B B B B B 8 B
226 Translation was SUCCESSFUL with 8 warning(s) (321€7 feature(s) output)
22€ FME Session Duration: 37.3 seconds. (CPU: 31.5%s user, 2.7s system)

227 E = = process memory usage: l€55%€0 kB, current process memory usage: 151008 kB
228 jTranslation was SUCCESSEU

v

Note: You may wish to keep these conversion settings for future use by clicking the Save button.

I'l. The features have now been written to the file geodatabase. Close the Interoperability workbench

window.

12. Next, load your translated data in the file geodatabase by selecting the Map tab at the top of the main
window, followed by Add Data.

Map

Insert Analysis View
- : A
(@ @ | II -(®-
Yy YNEKR ]
Explore 2R N Bookmarks Go
= v To XY
Navigate s

Edit

EE
[

Basemap

Imag

-+

Add
Data~

Layer
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I 3. Navigate to where the file geodatabase (.gdb) is stored and select it.

14. Select the features you require from Route, RouteLink and / or RouteNode, then click OK.

Add Data

© ) @|E« project

» Databases » MyProject.gdb

Organize ~ Newltem ~

4 (¢ Project

Name

[ g Databases

[E5] Route

o Folders
4 § Portal
&' My Content
# Groups
> All Portal
B Living Atlas
4 [[1 Computer
Desktop

(=) RouteLink

) RouteNode

Name Default

v I('_) Search Project

o
¢ ER

Type

File Geodatabase 1

File Geodatabase f

File Geodatabase F

Cancel

I5. You should see your selected features with geometry appear in the main map window. You can style or

annotate this using the various ArcGIS Pro tools and options available.

Drawing Order

4[] RouteLink

4 Standalone Tables

M Foute

7| World Light Gray Canvas

Base

Project Portal A

Note: The file geodatabase created using the Interoperability Extension can also be opened in older versions of
ArcMap. This is described in the following section.
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3.3 ArcMap

These instructions are based on ArcMap version 10.5.
Note: Section 3.3.1 requires users to have access to a licence for ArcGIS Pro and knowledge of converting files with
the appropriate Interoperability Extension. The following steps show how to load a file geodatabase that has been

created using the steps outlined in the prior ArcGlIS Pro section.

Note: If you do not have a licence for ArcGIS Pro and / or the Full Data Interoperability Extension, Section 3.3.2
steps through how to create a file geodatabase using the free ArcMap version of the Data Interoperability tool.

3.3.1 Loading a file geodatabase in ArcMap
I. Launch ArcMap.

2. Click the Add Data button in the top menu.

3. Navigate to the file geodatabase (.gdb) created using ArcGIS Pro’s Interoperability Extension (see the
notes above and the instructions in the previous section).

Add Data X

Lookin: | ] MyProject v EY s

—lImportLog
EIndex

P MyProject.gdb

25 MyProject.tbx

- = 7
Name: | MyProject.gdb | Add |

Show of type: | patasets, Layers and Resuits w Cancel

4. Select the file geodatabase (.gdb) and click Add.
5. You'll see three Feature Types listed:

a. Route — A lookup table that records collections of links representing a named entity which forms a
recognised and signed route that the public can use.

b. RouteLink — Line geometry representing the general alignment of roads, tracks, paths and rights of
way.

c. RouteNode — Point geometry at the start or end of a RouteLink feature which is used to record
the connectivity between links.
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Add Data

Look in: __J MyProject.gdb

Route
| =] RouteLink
" RouteNode

Name:

[ Add

Show of type: Datasets, Layers and Results

Cancel

For further details on the product structure and attribution of each of the feature types, please refer to

the OS Detailed Path Network — Technical Specification document, which is available on the
OS Detailed Path Network Product Support page of the OS website

(https://www.ordnancesurvey.co.uk/business-government/tools-support/path-network-support).

6. Select the features required and click Add.

7. The selected features with geometry will load into the main map window. You can now select a suitable

mapping backdrop and style the map using the symbology tools available within ArcMap.

File Edt View Bockmarks Insert Selecion Geoprocessing Customize Windows Help
Deds B x |0 | & [ i BEEEO
CEEY - T -0 @7 BIRASS TR
[Fable OF Contents 8 x
::F< : B H
Layers
= L C\DataGetting_Started_t
B FRoutehNode
.
- & Routelink
] foute]
t
o

© Ordnance Survey Ltd 2021

Page 18 of 30


https://www.ordnancesurvey.co.uk/business-government/tools-support/path-network-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/path-network-support

OS DETAILED PATH NETWORK — GETTING STARTED GUIDE
October 2021

3.3.2  Converting GML to a file geodatabase and loading with ArcMap
I. Open ArcCatalog and open the Arc Toolbox window.

2. Select System Toolboxes, then Data Interoperability Tools and click Quick Import.

:atalogTree % X | Contents Preview Description

Name Type

* Quick Export Toolbox Tool
% Quick Import Toolbox Tool

) &9 3D Analyst Tools.tbx
@ Q Analysis Tools.tbx
® ° Cartcgraphy Tools.thx

Data Interoperability Tools.tbx

] Data Management Tools.tbx
€3] ° Editing Tools.tbx

+ Geocoding Tools.thx
Z+Z g Geostatistical Analyst Tools.thx
& ° Linear Referencing Tools.thx
@ @ Multidimension Tools.tbx
# &P Network Analyst Tools.thx
& % Parcel Fabric Tools.thx
° Schematics Tools.tbx
Q Server Tools.tbx
E‘ Space Time Pattern Mining Tools.pyt
E & Spatial Analyst Tools.tbx
- @ Spatial Statistics Tools.tbx
+ & Tracking Analyst Tools.tbx

= B

—

3. Click on the [...] button next to the Input Dataset box, then navigate to the location of your
OS Detailed Path Network GML data and select it.

. Quick Import - [m} X

& Input Dataset

® Output Staging Geodatabase

& Specif

Reader

Format: |'aphy Markup Language Simple Features Level SF-0 Profile) VI

1=l ta \Original DataWEW FOREST NATIONAL PARK.g | | |7

Parameters... Coord. System: |Re

Help

E Cancel Environments. .. Show Help >>

4. Click OK.
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5. In the Output Staging Geodatabase option, give the new file geodatabase a suitable name in the Name

section, then click Save.

Output Staging Geodatabase

Look in: E pata v %[ =

[T Geodatabase
[1Geopackage
EMyProject
£ Original Data
1 Shape
E31AB

Name: Detailed_Paths|

| I Save

Saveastype!  Gegdatabases

v Cancel

6. Click OK to start the Quick Import.

7. A message will appear in ArcCatalog when the process is complete. Once the process has finished,

start ArcMap or select it if it is already running.

8. Click Add Data from the top menu.

&-

9. Navigate to the new file geodatabase that you just created in Step 5.

Add Data

Lookin: ||} Detalled_Paths.gdb

Jewmals

BHEOS

Route
5 Routelink
"] RouteNode

Name: l |

Show of type: | patasets, Layers and Results

A Cancel

10. You'll see the features of OS Detailed Path Network available for loading (Route, RouteLink and

RouteNode). Select the features you require, then click Add.
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I'l. The OS Detailed Path Network data will now load into the map window of ArcMap. You can now
select a suitable mapping backdrop and style the map using the symbology tools available within

ArcMap.

T T ™ -

8 @0 =i Y YT
psie OF Contents x
EIEL e
) Layers
= 0 CADwa\Getting Started §
H Routeblode
.
= B Rowtelink

mEm

2IBE o g

N2Eds Ax = & - ([LI6147 A EEEEO

rid St A
‘*' e .
i T

AR

I2. When you're finished styling your map, save the project as a .MXD file.
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3.4 MaplInfo Professional

The following instructions are based on Mapinfo Professional version 16.0.4.

I. Open Maplnfo Professional.

2. Select the MAP tab at the top of the ribbon menu. Click Open > Universal Data.

c 3@

“

[T

Open

41

m HOME TABLE

MAI

Add To Cosmetic

Map ~ v

Content

p

SPATIAL

R

Select

-

Selection

3. In the Specify Data Source dialog box that opens, select GML as the Format to be converted, then click
the [...] button at the end of Dataset field and navigate to the OS Detailed Path Network GML file.

Select that file and click OK.

e

Reader

Format: | GML (Geography Markup Language)

W

Dataset: Jta\Original Data\NEW FOREST NATIONAL PARK.gml"| |...| &%

Parameters...

Help

Coord. System: |R~.-.=.r: fi

om sourc

(]

oK

Cancel

4. You'll see three layers listed in the Select Layers dialog box that opens:

a. Route — A lookup table that records collections of links representing a named entity which forms a
recognised and signed route that the public can use.
b. RouteLink — Line geometry representing the general alignment of roads, tracks, paths and rights of

way.

c. RouteNode — Point geometry at the start or end of a RouteLink feature which is used to record

the connectivity between links.

For further details on the product structure and attribution of each of the features, please refer to the
OS Detailed Path Network — Technical Specification document, which is available on the OS Detailed
Path Network Product Support page of the OS website (https://www.ordnancesurvey.co.uk/business-

government/tools-support/path-network-support).
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5. Tick the layers you require.

Select Layers

Open Layer Name File Name
RouteNode * RouteNode.tab
M Routelink 4 RouteLink. tab
Route Route.tab

File Name:

Apply to Selected Layers

o |

Apply to All Layers

[Juse color information from dataset Do not open empty layers

Directory: C:\Data\Getting_Started_Guides\Detailed Path Network\Data\TAB\

Preferred View: | cirrent Mapper v

Cancel
< Back

Check All

Uncheck Al

Help

6. The Import process converts these layers from GML to TAB format. In the Directory box, navigate

with the [...] button to the location you wish to import the TAB files.

Note: Optionally, you’ll see you can apply styling at this point, though this can also be applied after the import.
Additionally, in the Preferred View box, you can either add each layer to the Current Mapper or create a New
Mapper. In this example, we’ll add to the Current Mapper to automatically load the converted layers.

7. Click OK to begin the translation from GML to TAB.
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8. Maplnfo Professional will automatically load the converted layers into the map window.

LR

& A

Apply Use Stacked
Styles  Styles

RASTER

Layes

Label

3 Route RouteNode RouteLink Map © %
X ¢ s Q
Maps ¥
4 Route,RouteNode Routelink Map L.}
< Cosmetic Layer
+ Route &
) Routetode &
& Reutelink d=ge
1 layer selected
Tables ¥
-
Rgnate
RowteLink
Routebode
Windaws ¥
Maps (1) ¥
| Bgute RowteNode Routelink Map
Tooks (1) ¥
| Explorer
Connections ¥
Zoom: 6427 km & Editing: None & Selecting: None British National Grid

Note: Styling can be added using the Apply Styles button which can be found under the Layer Tools tab on the

top m
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3.5 Cadcorp SIS Map Express

Cadcorp SIS Map Express is a free viewer that automatically loads OS Detailed Path Network GML data.
Simply open the application and drag and drop the GML file into the map window, as shown in the

following screenshot:

B U-2ad-a-8aq ds Cadieorp SIS Map Express - Map 1

I o vew ~@-
o, 2 A Q Q Q 47 vxaases YT (H Eree veET
A e ;(“ n o Bor Gueerr uep ) AR AR O o L A ]
i Toom Pen Selectivn REgaiuttmnt

Mapt - a

) 565 Workipace Defintion:
W Map 1

Gettang_Stanted Guedes » Detaded Path Network » Dty » ©

Y NEW FOREST NATIONAL PARK. gfs
5P NEWE FOREST MATIOMAL PARK. gemi
W NEW FOREST MATIOMAL PARK 5ip
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3.6 Cadcorp SIS Map Modeller

The following instructions are based on the full application of Cadcorp SIS Map Modeller version 9.

I. Launch Cadcorp Map Modeller.

2. In the main Cadcorp map application window, select Add Overlay from the top menu.

=~ |~
-3 —
Add Pve
Overlay

3. In the Overlay Types dialog box that opens, select Files > File > Next.

Overlay Types

Databases

06C

Ordnance Survey (GB)
Web

Analysis

Miscellaneous

Recently used

Select one of the available Overlay types

File
D Afile-based dataset &

New File

A new, editable file-Dased dataset 2

Imported File
-> A dataset created by importing data from a file-based dataset <

Index Dataset
@ Tiles together multiple file-based datasets in a rectangular +

grid, to make a continuous map base

(T Raster Index
:H: An index of all of the the raster files in a folder, or tree of &

folders

Next > Cancel
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4. Navigate to where you’ve placed the OS Detailed Path Network data and click on the relevant GML

file(s).

File Browser x

Browse for one or more dataset files to add. Press the Configure... button to control how each dataset

€ loads
™ <« Data » Getting_Stated_Guides » Detaled Path Netwok » Data » Orignal Data
New Folder 8 -
Name A Size Type Modffied
IEBRECON BEACONS NATIONAL PARK grrﬂl 75055 KB GML File 13/09/2019 5:0..
B BR I Al TA99KB PowerArchiver.. 13/09/2019 4:0..
i NEW FOREST NATIONAL PARK gml 50.724 KB GML File 06/09/2019 4.0..
" NEW FOREST NATIONAL PARK zip 4516 KB PowerArchiver...  06/09/2019 3.0..
File name: | | | Al known formats

=T

Cancel

5. At this point, you can also apply the OS XSD schema
(https://www.ordnancesurvey.co.uk/xml/schema/detailedPathNetwork/v|/detailedPathNetwork.xsd; the

schema is detailed in Section 2.1 of the guide) by clicking Configure > Preload custom GML application
schema. Click Browse... and navigate to the folder where you downloaded the schema file. Select it and

click OK.

Configure 0GC GML Dataset

XML parser configuration

v| Validate GML document

GML schema preload configuration

Do not preload a GML schema
Preload GML 2.1.2 schema
Preload GML 3.1.1 schema
Preload GML 3.2.1 schema

I ® Preload custom GML application schema I

GML application schema

C:\Data\Getting_Started_Guides\Detailed Path Network\Data\Original Browse...

Axes order configuration

The GML 3.x specffications require that co-ordinate pairs are ordered (e.g. lat/lon or lonAat)
according to the axes order of the GML feature’s co-ordinate reference system (CRS).
Change this setting when the GML version or the CRS axes order cannot be detected

¢ Detect automatically whether axes need to be swapped
Do not swap axes

Do swap axes
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6. Click Finish. The data will now load into the main map window.

] pp—
s [ Te W va
Select o m ?0 :‘j « Distance  Atea

Messurement

(g ax@ea@on (%
@O % LD AR W

Tocm

File it : el
SZEATT QQ !

Add Overlays Add  Query
Overtay Theme Buider () CRS

Selection

Map

v 3 x |[FaMap2 x

Maps

M SIS Workspace Defritions
o [ Map 2

Eluags | Mpnpesis <

The full Cadcorp SIS Map Modeller application allows you to apply different styles to the data as
required. If you wish, these styles can be saved as documents for future use, and they will also work in

the free Cadcorp SIS Map Express application (see Section 3.5 for more information on that

application).
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4.  Loading the data (GeoPackage format)

This getting started guide focuses solely on using the product in GML format. For guidance on using the
product in GeoPackage format, please see the Getting Started with GeoPackage guide
(https://www.ordnancesurvey.co.uk/documents/getting-started-with-geopackage.pdf) which is available on
the OS website.

5. Loading the data (vector tiles format)

This getting started guide focuses solely on using the product in GML format. For guidance on using the
product in vector tiles format, please see the Getting Started with Vector Tiles guide
(https://www.ordnancesurvey.co.uk/documents/user-guides/getting-started-with-vector-tiles-v1.0.pdf) which
is available on the OS website.
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Annex A: Product support links

¢ OS Detailed Path Network Product Support page on the OS website
(https://www.ordnancesurvey.co.uk/business-government/tools-support/path-network-support)

¢ OS Detailed Path Network Overview document (https://www.ordnancesurvey.co.uk/business-
government/tools-support/path-network-support)

e OS Detailed Path Network Technical Specification document
(https://www.ordnancesurvey.co.uk/business-government/tools-support/path-network-support)

¢ OS Detailed Path Network product schema
(https://www.ordnancesurvey.co.uk/xml/schema/detailedPathNetwork/v | /detailedPathNetwork.xsd)

* Getting Started with GeoPackage guide on the OS website
(https://www.ordnancesurvey.co.uk/documents/getting-started-with-seopackage.pdf)

*  Getting Started with Vector Tiles suide on the OS website
(https://www.ordnancesurvey.co.uk/documents/user-guides/getting-started-with-vector-tiles-v1.0.pdf)
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